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Register your device
Register your device to your MyCAEN+ account and get access to our customer services, such as
notification for new firmware or software upgrade, tracking service procedures or open a ticket for
assistance. MyCAEN+ accounts have a dedicated support service for their registered products. A set of
basic information can be shared with the operator, speeding up the troubleshooting process and
improving the efficiency of the support interactions.

MyCAEN+ dashboard is designed to offer you a direct access to all our after sales services. Registration
is totally free, to create an account go to https://www.caen.it/become-mycaenplus-user and fill the
registration form with your data.
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1. Introduction 
Overview 

CAEN has taken a new step forward in power supplies' ease of use and integration into Detector Control Systems 
(DCS). A newly released suite of applications guarantees CAEN power supplies' interoperability between virtually all 
available computing  environments and communication protocols (TCP/IP, CANbus...).  
 
In the latest years OPC (OLE for Process Control) has clearly emerged as one of the most popular standards in the 
world of industry automation. OPC  is an open interface based on the OLE/COM (now ActiveX) and  DCOM 
technology; OPC offers "Plug&Play" connectivity between disparate hardware devices. The introduction of the OPC 
interface has caused the number of driver developments which hardware manufacturers implement for their 
components  to be reduced  to only  one: the OPC server. On  the other hand, OPC client applications (from any 
vendor) can communicate with the OPC server to exchange data in a standard way. Each device property is 
accessed via an OPC item. An OPC server  creates OPC items on behalf of an OPC client. The client's OPC items are 
organised in OPC groups with a hierarchical structure.  
 
CAEN, in close collaboration with CERN (IT/CO group), has developed an OPC server which allows powerful, flexible, 
and yet simple control of its power supply systems, through various communication path, by any OPC compliant 
client application.  
 
CAEN HV OPC Server is fully compliant with the OPC Data Access 2.0 specifications; this version provides: 
 
• CAEN Power Supply Systems, V65XX power supplies, VME8x00 crates 
• CONET, USB2.0, TCP/IP caenecommunication path 
• DCOM based interface for local/remote OPC server configuration 

Support 
Our Software Support Group is available for questions, support and any other software related issue concerning 
CAEN Power Supplies; for software support visit the page http://www.caen.it/computing/support.php 
 
Moreover, a newsletter on CAEN Software issues (CAEN SOFTWARE NEWS) will be periodically sent via e-mail to all 
subscribers to our mailing list. For subscription to the free newsletter send an e-mail to support.computing@caen.it  

 

http://www.caen.it/computing/support.php
mailto:swsupport@caen.it
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2. Installation and configuration 
Install the OPC server  

Unzip the CAENHVOPCServer_5.x.zip file and then launch setup.exe; this will install all the OPC server (version 5.x) 
components on your local machine. The OPC server will be configured as a Windows OS service. 

OPC server configuration interface 
The software release 5.X has a new user interface, based on DCOM technology, which allows remote configuration 
of the OPC server. A sample configuration program is provided (OPC Server Configurator) 

CAEN OPC server configurator tool 
Installation 

Unzip the CAENHVOPCServerConfiguratorSetup zip file and then launch setup.exe; this will install the CAEN HV OPC 
Server Configurator components on your local machine. 

OPC Server configuration 
From Start/Programs/CAEN run CAEN HV OPC Server Configurator, the following window will be displayed: 

 
Fig. 1: CAEN HV OPC Server Configurator start up window 
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Click on the Add Entry button, one of the following windows will be displayed, depending on the selected device: 
SY1527/2527 SY4527/5527 

  
VME8x00 TCP/IP VME8x00 USB VCP 

  
V65xx USB V65xx PCI OPTICAL LINK 

  

Fig. 2: Connection parameters 

Once entered the Power Supply Name in the relevant field, the Connection Type  must be selected; then enter the 
correct connection parameters and click on  the OK button, the following window will be displayed. 
Possible values for Status are: Ko, Ok or Pending. The Status is Pending immediately after adding a new Entry, until 
the OPC Server has connected to the Power Supply, then it becomes either Ok or Ko, depending whether the 
connection is successful or faulty. 
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Fig. 3: Configuring an Entry 

Select a P.S. name and click on the Configure Entry button to open the relevant Configuration File; insert all desired 
system, board and channel items (cfr. § 3 “Server address space description“) and then, from the File menu, select 
Send to Server (optionally it is possible to save a local copy of the Configuration file). 
To configure another power supply system, simply click on the Add Entry button and repeat the steps described 
above.  
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3. Server address space description 

OPC groups and items 
The OPC groups provide a way for clients to organise the data they want to access to; within each group, the OPC 
items represent connections to data sources; several data types are supported: boolean, integer, string, …. The 
server address space has a tree-like structure which will be described in detail in the next chapter; OPC clients can 
browse the available data items in the server like illustrated in the figure below. 

 

Fig. 4: Browsing the server address space 

Data access mechanism 
Four communication mechanisms have been defined for data access: synchronous and asynchronous read/write, 
refresh and subscription; the client defines the update rate at which the items’ values will be refreshed by the 
server. When a client subscribes to a list of Items, the server notifies it if any data change occurs. The client can 
optionally specify a band of tolerance (or deadband) so that it is not notified by the server if the changes are within 
a fixed percentage of the data range. 

Items properties 
Associated with each Item there is a set of Specific properties: Canonical Data Type, Value, Quality Flag (Good/Bad), 
Time Stamp, Access Rights, Server Scan Rate. The Time Stamp indicates the time the Value and the Quality was 
obtained from the device. With OPC Data Access 2.0 a second set of Recommended properties has been released: 
the CAEN OPC Server provides Engineering Units (EU), High EU (the highest value that can be returned from the 
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device for analog data), Low EU (the lowest value that can be returned from the device for analog data) and the 
Contact Close/Open Labels (CLOSE/OPEN strings associated with boolean values). 
 
Each item is fully identified in the server address space during data access by an ItemID; the ItemID has the 
following general syntax: 
 
PowerSupplyName.BoardXX.ChanYYY.ItemName 
 
Items of the kind PowerSupplyName.ItemName are associated with general system parameters. 
 
Items of the kind PowerSupplyName.BoardXX.ItemName are associated with boards’ parameters. 
 
Items of the kind PowerSupplyName.BoardXX.ChanYYY.ItemName are associated with channels’ parameters. 
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4. SY4527 / SY5527 Power Supply System 
This chapter describes the OPC Items which are available for the SY 4527 / SY 5527 system control.  

SY4527 / SY5527 System control 
OPC Items available for general system control are fully listed in Table 1. For a detailed description of the SY4527 / 
SY5527 system operation, refer to SYx527 User’s manual 
 
A write access to the Kill Item (Value = 1) allows to switch OFF at the max rate all system channels; 
 
A write access to the Clear Alarm Item (Value = 1) allows to clear channels’ alarm messages; 
 
A read access to the Sessions Item returns a string with the list of Users connected to the system, their access level, 
communication line and access time; 
 
A read access to the ModelName Item returns a string indicating the system model (SY4527, SY5527, …). 
 
A read access to the SwRelease Item returns a string indicating the system firmware release (example: 2.00.00). 
 
The GenSignCfg Item allows to configure the GEN signal by writing an 16 bit pattern as follows: 
 

 Bit 0: GEN enable 
 Bit 1: GEN always ON 
 Bit 2: GEN ON due to OvV (Over Voltage) 
 Bit 3: GEN ON due to OvC (Over Current) 
 Bit 4: GEN ON due to UnV (Under Voltage) 
 Bit 5: GEN ON due to TRIP 
 Bit 6÷7: Don’t care (=0) 
 Bit 8: GEN enable MASK 
 Bit 9: GEN always ON MASK 
 Bit 10: GEN ON due to OvV (Over Voltage) MASK 
 Bit 11: GEN ON due to OvC (Over Current) MASK 
 Bit 12: GEN ON due to UnV (Under Voltage) MASK 
 Bit 13: GEN ON due to TRIP MASK 
 Bit 14÷15: Don’t care (=0) 
 

This Item is a 2-byte integer; in order to set or reset bits 0..5, it is necessary to set to 1 the corresponding “MASK” 
bit (bits 8..13). 

 
A read access to the FrontPanIn Item returns a 16 bit patterns indicating the system inputs and switches status, as 
follows: 
 

 Bit 0: Vsel, 0=V0 1=V1  
 Bit 1: Isel, 0=I0 1=I1 
 Bit 2: Kill 
 Bit 3: Interlock 
 Bit 4: Remote Enable 
 Bit 5: Local Enable 
 Bit 6: TTL/NIM, 0=TTL 1=NIM 
 Bit 7÷15: Don’t care (=0) 

 
A read access to the FrontPanOut Item returns a 16 bit patterns indicating the system outputs status, as follows: 
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 Bit 0: OVC 
 Bit 1: UNV 
 Bit 2: OVV 
 Bit 3: CHON 
 Bit 4÷7: Don’t care (=0) 
 Bit 8: Fan failure 
 Bit 9: OVT 

 Bit 10÷15: Don’t care (=0) 
 
The ResFlagCfg Item allows to configure the system reset by writing an 16 bit pattern as follows: 
 

 Bit 0: backplane reset due to CPU failure 
 Bit 1: always set to 1 
 Bit 2: backplane reset due to front panel reset input signal 
 Bit 3: CPU reset due to front panel reset input signal 
 Bit 4÷5: always set to 1 
 Bit 6÷15: always set to 0 
 

A read access to the HvPwSM Item returns a string with the power supply module status, like follows: 
“ACstatus:Primary:Add 0:Add 1:Add 2 ”. If: 
 
 ACstatus = -1 ⇒ FAIL 
   ACstatus =  1 ⇒ GOOD 
 Primary =  -1 ⇒ Primary supply module FAIL 
 Primary =  1 ⇒ Primary supply module GOOD 
 Add X =  -1 ⇒ Add on supply module nr. X  FAIL 
 Add X =   0 ⇒ Add on supply module nr. X  NOT PRESENT 
 Add X =   1 ⇒ Add on supply module nr. X  GOOD 
 
A read access to the HVFanStat Item returns a string with the cooling fans status. If: 
 
 status = -1 ⇒ FAIL 
   status =  1 ⇒ GOOD 
 
A read access to the HVFanSpeed Item returns a string with the cooling fans speed, The speed parameter is 
expressed in rpm. 
 
A read access to the ClkFreq Item returns an integer idicating the clock frequency as follows: 
 
 ClkFreq = -1 ⇒ FAIL 
 ClkFreq =  0 ⇒ 50 Hz 
 ClkFreq =  1 ⇒ 60 Hz 
 ClkFreq =  2 ⇒ 400 Hz 
 
A read access to the HVClkConf Item returns a string with the clock configuration like “clock:status”, where if: 
 
 Clock = 1 ⇒ MASTER 
 Clock = 0 ⇒ SLAVE 
 Status = -1 ⇒ FAIL 
 Status =  0 ⇒ NOT PRESENT 
 Status = +1 ⇒ GOOD 
 
The IPaddress item allows to specify the system IP address (for example 192.168. 0.1); 
 
The IPNetMsk  item allows to specify the system IP net mask (for example 255.255.255.0);  
 
The IPGw item allows to specify the system IP gateway (for example 0.0.0.0); 
 
A read access to the Slots Item returns  the number of system’s slots.  
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A read access to the ConnStatus Item returns a string with the connection status of the system. If: 
 
 status = OK ⇒ CONNECTED 
   status = KO ⇒ DISCONNECTED 
 
The CPULoad item allows to monitor the load on the system CPU 
This item has the following format: value1:value5:value15 
Value1, value5 and value15 are the average CPU loads, calculated respectively over one, five and  fifteen minutes. 
 
The CmdQueueStatus item allows to monitor the number of commands in queue in the system; if CmdQueueStatus 
>0 then the System is performing commands on the boards, therefore monitor values may not be updated until all 
queued commands are executed. As soon as all commands are performed and CmdQueueStatus returns to 0, 
monitor values are updated to correct values. 
 
The MemoryStatus item allows to monitor the system memory usage 
This item has the following format: value0:value1:value2:value3  
Value0 is the total memory, value1 is the used memory, value2 is the free memory,  value3 is the buffers memory 

Table 1 – SY4527/ SY5527 System Items 

ItemID Data Type Access Rights  Description 
PowerSupplyName.Kill Boolean W Kill all channels 
PowerSupplyName.ClearAlarm Boolean W Clear alarm 
PowerSupplyName.Sessions String R List Users connected to system 
PowerSupplyName.ModelName String R System name  
PowerSupplyName.SwRelease String R System firmware release 
PowerSupplyName.GenSignCfg 2-byte integer R/W GEN signal configuration 
PowerSupplyName.FrontPanIn 2-byte integer R System input status 
PowerSupplyName.FrontPanOut 2-byte integer R System output status 
PowerSupplyName.ResFlagCfg 2-byte integer R/W Reset Flag configuration 
PowerSupplyName.ResFlag 2-byte integer R Reset Flag status 
PowerSupplyName.HvPwSM String R Power supply modules status 
PowerSupplyName.HVFanStat String R Fan status 

PowerSupplyName.HVFanSpeed String R Fan speed 
PowerSupplyName.ClkFreq 2-byte integer R Clock frequency 
PowerSupplyName.HVClkConf String R Clock configuration 
PowerSupplyName.IPAddr String R/W System IP address 
PowerSupplyName.IPNetMsk String R/W System IP net mask 
PowerSupplyName.IPGw String R/W System IP gateway 
PowerSupplyName.SymbolicName String R/W System symbolic name 
PowerSupplyName.Slots 2-byte integer R Slots number 
PowerSupplyName.ConnStatus String R connection status 
PowerSupplyName.CPULoad 2-byte integer R load on the system CPU 
PowerSupplyName.CmdQueueStatus 2-byte integer R number of commands in queue 
PowerSupplyName.MemoryStatus 2-byte integer R system memory usage 

SY4527 / SY5527 Board control 
This chapter describes the Items which are available for the control of a generic SY4527 / SY5527 system board  
(for example the Mod. A 1832N). The list of Items may differ for some custom boards (refer to the board’s manual 
for further details). 
 
A read access to the Model Item returns a string with the board model. 
 
A read access to the Description Item returns a string with the board synthetic description (for example “12 Ch Neg 
6 kV 1/0.2 mA”). 
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A read access to the Fmw Release item returns a string with the board firmware release. 
 
A read access to the SerNum item returns the board serial number. 
 
A read access to the NrOfCh item returns the number of board’s channels. 
 
A read access to the BdStatus item returns the status of generic board's parameters, namely: 
 
bit 0: PowerFail; if 1, it indicates a failure in the channels local power supply 
bit 1: Firwmare Checksum Error; if 1, it indicates an error in the board firmware checksum 
bit 2: HVMax Calibration Error; if 1, it indicates that the board HVMax parameter (if present) is not calibrated 
bit 3: Temperature Calibration Error; if 1, it indicates that the board temperature sensor (if present) is not calibrated 
bit 4: Under Temperature; if 1, it indicates that the board temperature sensor (if present) signals a board 
temperature < 5 °C 
bit 5: Over Temperature; if 1, it indicates that the board temperature sensor (if present) signals a board 
temperature > 65 °C 
bits 6..31: Reserved for future use 
 
A read access to the HVMax item returns the voltage hardware limit set by trimmer on the board. 
 
A read access to the HVMax#EU item returns a string with the HVMax Engineering Units. 
 
A read access to the HVMax#HighEU item returns the highest possible HVMax value. 
 
A read access to the HVMax#LowEU item returns the lowest possible HVMax value. 
 
A read access to the Temp item returns the board’s temperature. 
 
A read access to the Temp#EU item returns a string with the Temp Engineering Units. 
 
A read access to the Temp#HighEU item returns the highest possible Temp value. 
 
A read access to the Temp#LowEU item returns the lowest possible Temp value. 

Table 2 – SY4527/ SY5527 Board items 

ItemID Data Type Access Rights  Description 
PowerSupplyName.BoardXX.Model String R Board model 
PowerSupplyName.BoardXX.Description String R Board description 
PowerSupplyName.BoardXX.Fmw Release String R Board firmware release 
PowerSupplyName.BoardXX.SerNum 2-byte integer R Board serial number 
PowerSupplyName.BoardXX.NrOfCh 2-byte integer R Number of channels 
PowerSupplyName.BoardXX.BdStatus 2-byte integer R Board status 
PowerSupplyName.BoardXX.HVMax 4-byte real R Hardware voltage limit 
PowerSupplyName.BoardXX.HVMax#EU String R HVMax EU 
PowerSupplyName.BoardXX.HVMax#HighEU 8-byte real R HVMax upper limit 
PowerSupplyName.BoardXX.HVMax#LowEU 8-byte real R HVMax lower limit 
PowerSupplyName.BoardXX.Temp 4-byte real R Board temperature 
PowerSupplyName.BoardXX.Temp#EU String R Temperature EU 
PowerSupplyName.BoardXX.Temp#HighEU 8-byte real R Temp upper limit 
PowerSupplyName.BoardXX.Temp#LowEU 8-byte real R Temp lower limit 

SY4527 / SY5527 Channel control 
This chapter describes the items which are available for the control of a generic channel within the  SY4527 / 
SY5527 system. The list of items may differ in case of channels belonging to custom boards (refer to the board’s 
manual for further details). 
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The Name item allows to assign to the channel a symbolic name. 
 
The V0set item allows to set V0; see SYx527 User’s manual for further details. 
 
A read access to the V0set#EU item returns a string with the V0set Engineering Units. 
 
A read access to the V0set#HighEU item returns the highest possible V0set value. 
 
A read access to the V0set#LowEU item returns the lowest possible V0set value. 

 
The I0set item allows to set I0; see SYx527 User’s manual for further details. 
 
A read access to the I0set#EU item returns a string with the I0set Engineering Units. 
 
A read access to the I0set#HighEU item returns the highest possible I0set value. 
 
A read access to the I0set#LowEU item returns the lowest possible I0set value. 
 
The V1set item allows to set V1; see SYx527 User’s manual, for further details. 
 
A read access to the V1set#EU item returns a string with the V1set Engineering Units. 
 
A read access to the V1set#HighEU item returns the highest possible V1set value. 
 
A read access to the V1set#LowEU item returns the lowest possible V1set value. 
 
The I1set item allows to set I1; see SYx527 User’s manual for further details. 
 
A read access to the I1set#EU item returns a string with the I1set Engineering Units. 
 
A read access to the I1set#HighEU item returns the highest possible I1set value. 
 
A read access to the I1set#LowEU item returns the lowest possible I1set value. 

 
The RUp item allows to program the ramp-up rate; see SYx527 User’s manual, for further details. 
 
A read access to the RUp#EU item returns a string with the RUp Engineering Units. 
 
A read access to the RUp#HighEU item returns the highest possible RUp value. 
 
A read access to the RUp#LowEU item returns the lowest possible RUp value. 
 
The RDWn item allows to program the ramp-down rate; see SYx527 User’s manual, for further details. 
 
A read access to the RDWn#EU item returns a string with the RDWn Engineering Units. 
 
A read access to the RDWn#HighEU item returns the highest possible RDWn value. 
 
A read access to the RDWn#LowEU item returns the lowest possible RDWn value. 
 
The Trip item allows to program the trip time; see SYx527 User’s manual,  for further details. 
 
A read access to the Trip#EU item returns a string with the Trip Engineering Units. 
 
A read access to the Trip#HighEU item returns the highest possible Trip value. 
 
A read access to the Trip#LowEU item returns the lowest possible Trip value. 
 
The SVMax item allows to set the software voltage limit; see SYx527 User’s manual,  for further details. 
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A read access to the SVMax#EU item returns a string with the SVMax Engineering Units. 
 
A read access to the SVMax#HighEU item returns the highest possible SVMax value. 
 
A read access to the SVMax#LowEU item returns the lowest possible SVMax value. 
 
The VMon item returns back the VMon value; see SYx527 User’s manual,  for further details. 
 
A read access to the VMon#EU item returns a string with the VMon Engineering Units. 
 
A read access to the VMon#HighEU item returns the highest possible VMon value. 
 
A read access to the VMon#LowEU item returns the lowest possible VMon value. 
 
The IMon item returns back the IMon value; see SYx527 User’s manual,  for further details. 
 
A read access to the IMon#EU item returns a string with the IMon Engineering Units. 
 
A read access to the IMon#HighEU item returns the highest possible IMon value. 
 
A read access to the IMon#LowEU item returns the lowest possible IMon value. 
 
A read access to the Status item returns back a 16 bit pattern indicating channel status, as follows: 
  
 Bit 0: ON/OFF 
 Bit 1: Ramp Up 
 Bit 2: Ramp Down 
 Bit 3: OverCurrent 
 Bit 4: OverVoltage 
 Bit 5: UnderVoltage 
 Bit 6: External Trip 
 Bit 7: Over HVmax 
 Bit 8: External Disable 
 Bit 9: Internal Trip 
 Bit 10: Calibration Error 

 Bit 11: Unplugged (“remote” boards only) 
 Bit12:  UnderCurrent 
 Bit13:  OverVoltage Protection 
 Bit14:  Power Fail 
 Bit15:  Temperature Error 

 
The Pw item allows to switch ON/OFF the channel. 
 
A read access to the Pw#CoOpen returns back the label “Off” associated to Pw=0. 
 
A read access to the Pw#CoClose item back the label “On” associated to Pw=1. 
 
The POn item allows to select the power ON option, as follows 
 
 POn=1 ⇒ Enabled 
 POn=0 ⇒  Disabled 
 
see SYx527 User’s manual for further details. 
 
A read access to the POn#CoOpen returns back the label “Disabled” associated to POn=0. 
 
A read access to the POn#CoClose item returns back the label “Enabled” associated to POn=1. 
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The PDwn item allows to select the power-down option, as follows 
 
 PDwn=1 ⇒ RAMP 
 PDwn=0 ⇒  KILL 
 
see SYx527 User’s manual,  for further details. 
 
A read access to the PDwn#CoOpen item returns back the label “Kill” associated to PDwn=0. 
 
A read access to the PDwn#CoClose item returns back the “Ramp” associated to PDwn=1. 
 
The TripInt item allows to program the internal trip time. 
 
A read access to the TripInt#EU item returns a string with the TripInt Engineering Units. 
 
A read access to the TripInt#HighEU item returns the highest possible TripInt value. 
 
A read access to the TripInt#LowEU item returns the lowest possible TripInt value. 
 
The TripExt item allows to program the external trip time. 
 
A read access to the TripExt#EU item returns a string with the TripExt Engineering Units. 
 
A read access to the TripExt#HighEU item returns the highest possible TripExt value. 
 
A read access to the TripExt#LowEU item returns the lowest possible TripExt value. 

Table 3 – SY4527/ SY5527 Channel items 

ItemID Data Type Access Type  Description 
PowerSupplyName.BoardXX.ChanYYY.Name String R/W Channel name 
PowerSupplyName.BoardXX.ChanYYY.V0Set 4-byte real R/W Set V0 voltage limit 
PowerSupplyName.BoardXX.ChanYYY.V0Set#EU String R V0set  EU 
PowerSupplyName.BoardXX.ChanYYY.V0Set#HighEU 8-byte real R V0set upper limit 
PowerSupplyName.BoardXX.ChanYYY.V0Set#LowEU 8-byte real R V0set lower limit 
PowerSupplyName.BoardXX.ChanYYY.I0Set 4-byte real R/W Set I0 current limit 
PowerSupplyName.BoardXX.ChanYYY.I0Set#EU String R I0set  EU 
PowerSupplyName.BoardXX.ChanYYY.I0Set#HighEU 8-byte real R I0set upper limit 
PowerSupplyName.BoardXX.ChanYYY.I0Set#LowEU 8-byte real R I0set lower limit 
PowerSupplyName.BoardXX.ChanYYY.V1Set 4-byte real R/W Set V1 voltage limit 
PowerSupplyName.BoardXX.ChanYYY.V1Set#EU String R V1set  EU 
PowerSupplyName.BoardXX.ChanYYY.V1Set#HighEU 8-byte real R V1set upper limit 
PowerSupplyName.BoardXX.ChanYYY.V1Set#LowEU 8-byte real R V1set lower limit 
PowerSupplyName.BoardXX.ChanYYY.I1Set 4-byte real R/W Set I1 current limit 
PowerSupplyName.BoardXX.ChanYYY.I1Set#EU String R I1set  EU 
PowerSupplyName.BoardXX.ChanYYY.I1Set#HighEU 8-byte real R I1set upper limit 
PowerSupplyName.BoardXX.ChanYYY.I1Set#LowEU 8-byte real R I1set lower limit 
PowerSupplyName.BoardXX.ChanYYY.RUp 4-byte real R/W Set ramp-up rate 
PowerSupplyName.BoardXX.ChanYYY.RUp #EU String R Ramp up rate EU 
PowerSupplyName.BoardXX.ChanYYY.RUp #HighEU 8-byte real R RUp upper limit 
PowerSupplyName.BoardXX.ChanYYY.RUp #LowEU 8-byte real R RUp lower limit 
PowerSupplyName.BoardXX.ChanYYY.RDWn 4-byte real R/W Set ramp-down rate 
PowerSupplyName.BoardXX.ChanYYY.RDWn #EU String R Ramp down rate EU 
PowerSupplyName.BoardXX.ChanYYY.RDWn #HighEU 8-byte real R RDwn upper limit 
PowerSupplyName.BoardXX.ChanYYY.RDWn #LowEU 8-byte real R RDwn lower limit 
PowerSupplyName.BoardXX.ChanYYY.Trip 4-byte real R/W Set trip time 
PowerSupplyName.BoardXX.ChanYYY.Trip #EU String R Trip time EU 
PowerSupplyName.BoardXX.ChanYYY.Trip #HighEU 8-byte real R Trip time upper limit 
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ItemID Data Type Access Type  Description 
PowerSupplyName.BoardXX.ChanYYY.Trip #LowEU 8-byte real R Trip time lower limit 
PowerSupplyName.BoardXX.ChanYYY.SVMax 4-byte real R/W Set software voltage limit 
PowerSupplyName.BoardXX.ChanYYY.SVMax #EU String R SVMax EU 
PowerSupplyName.BoardXX.ChanYYY.SVMax#HighU 8-byte real R SVMax upper limit 
PowerSupplyName.BoardXX.ChanYYY.SVMax#LowEU 8-byte real R SVMax lower limit 
PowerSupplyName.BoardXX.ChanYYY.VMon 4-byte real R VMon 
PowerSupplyName.BoardXX.ChanYYY.VMon #EU string R VMon EU 
PowerSupplyName.BoardXX.ChanYYY.VMon#HighU 8-byte real R VMon upper limit 
PowerSupplyName.BoardXX.ChanYYY.VMon#LowEU 8-byte real R VMon lower limit 
PowerSupplyName.BoardXX.ChanYYY.IMon 4-byte real R IMon 
PowerSupplyName.BoardXX.ChanYYY.IMon #EU string R IMon EU 
PowerSupplyName.BoardXX.ChanYYY.IMon#HighU 8-byte real R IMon upper limit 
PowerSupplyName.BoardXX.ChanYYY.IMon#LowEU 8-byte real R IMon lower limit 
PowerSupplyName.BoardXX.ChanYYY.Status 2-byte integer R Channel status 
PowerSupplyName.BoardXX.ChanYYY.Pw boolean R/W Power ON/OFF 
PowerSupplyName.BoardXX.ChanYYY.Pw#CoClose string R Pw close label 
PowerSupplyName.BoardXX.ChanYYY.Pw#CoOpen string R Pw open label 
PowerSupplyName.BoardXX.ChanYYY.POn boolean R/W Power ON options 
PowerSupplyName.BoardXX.ChanYYY.POn#CoClose string R POn close label 
PowerSupplyName.BoardXX.ChanYYY.POn#CoOpen string R POn open label 
PowerSupplyName.BoardXX.ChanYYY.PDwn boolean R/W Power down options  
PowerSupplyName.BoardXX.ChanYYY.PDwn#CoClose string R PDwn close label 
PowerSupplyName.BoardXX.ChanYYY.PDwn#CoOpen string R PDwn open label 
PowerSupplyName.BoardXX.ChanYYY.TripInt 4-byte real R/W Set Internal trip time 
PowerSupplyName.BoardXX.ChanYYY.TripInt #EU string R Internal Trip time EU 
PowerSupplyName.BoardXX.ChanYYY.TripInt#HighU 8-byte real R Int. Trip time upper limit 
PowerSupplyName.BoardXX.ChanYYY.TripInt#LowEU 8-byte real R Int. Trip time lower limit 
PowerSupplyName.BoardXX.ChanYYY.TripExt 4-byte real R/W Set external trip time 
PowerSupplyName.BoardXX.ChanYYY.TripExt #EU string R External Trip time EU 
PowerSupplyName.BoardXX.ChanYYY.TripExt#HighU 8-byte real R Ext. Trip time upper limit 
PowerSupplyName.BoardXX.ChanYYY.TripExt#LowEU 8-byte real R Ext. Trip time lower limit 
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5. SY1527 / SY2527 Power Supply System 
This chapter describes the OPC Items which are available for the SY 1527 / SY 2527 system control.  

SY1527 / SY2527 System control 
OPC Items available for general system control are fully listed in Table 4. For a detailed description of the SY 1527 / 
SY 2527 system operation, refer to System User’s manual. 
 
A write access to the Kill Item (Value = 1) allows to switch OFF at the max rate all system channels; 
 
A write access to the Clear Alarm Item (Value = 1) allows to clear channels’ alarm messages;  
 
A write access to the Format Item (Value = 1) causes the  Format command to be executed ;   
 
A read access to the Sessions Item returns a string with the list of Users connected to the system, their access level, 
communication line and access time; 
 
A read access to the ModelName Item returns a string indicating the system model (SY1527, SY2527, …). 
 
A read access to the SwRelease Item returns a string indicating the system firmware release (1.10.00 or later). 
 
The GenSignCfg Item allows to configure the GEN signal by writing an 16 bit pattern as follows: 
 

 Bit 0: GEN enable 
 Bit 1: GEN always ON 
 Bit 2: GEN ON due to OvV (Over Voltage) 
 Bit 3: GEN ON due to OvC (Over Current) 
 Bit 4: GEN ON due to UnV (Under Voltage) 
 Bit 5: GEN ON due to TRIP 
 Bit 6÷7: Don’t care (=0) 
 Bit 8: GEN enable MASK 
 Bit 9: GEN always ON MASK 
 Bit 10: GEN ON due to OvV (Over Voltage) MASK 
 Bit 11: GEN ON due to OvC (Over Current) MASK 
 Bit 12: GEN ON due to UnV (Under Voltage) MASK 
 Bit 13: GEN ON due to TRIP MASK 
 Bit 14÷15: Don’t care (=0) 
 

This Item is a 2-byte integer; in order to set or reset bits 0..5, it is necessary to set to 1 the corresponding “MASK” 
bit (bits 8..13). 

 
A read access to the FrontPanIn Item returns a 16 bit patterns indicating the system inputs and switches status, as 
follows: 
 

 Bit 0: Vsel, 0=V0 1=V1  
 Bit 1: Isel, 0=I0 1=I1 
 Bit 2: Kill 
 Bit 3: Interlock 
 Bit 4: Remote Enable 
 Bit 5: Local Enable 
 Bit 6: TTL/NIM, 0=TTL 1=NIM 
 Bit 7÷15: Don’t care (=0) 
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A read access to the FrontPanOut Item returns a 16 bit patterns indicating the system outputs status, as follows: 
 

 Bit 0: OVC 
 Bit 1: UNV 
 Bit 2: OVV 
 Bit 3: CHON 
 Bit 4÷7: Don’t care (=0) 
 Bit 8: Fan failure 
 Bit 9: OVT 

 Bit 10÷15: Don’t care (=0) 
 
A read access to the HvPwSM Item returns a string with the power supply module status, like follows: 
“ACstatus:Primary:Add 0:Add 1:Add 2 ”. If: 
 
 ACstatus = -1 ⇒ FAIL 
   ACstatus =  1 ⇒ GOOD 
 Primary =  -1 ⇒ Primary supply module FAIL 
 Primary =  1 ⇒ Primary supply module GOOD 
 Add X =  -1 ⇒ Add on supply module nr. X  FAIL 
 Add X =   0 ⇒ Add on supply module nr. X  NOT PRESENT 
 Add X =   1 ⇒ Add on supply module nr. X  GOOD 
 
A read access to the FanStat Item returns a string with the 6 fans (3 for the SY 2527) status and speed, like follows: 
“status:speed: status:speed: … status:speed”. If: 
 
 status = -1 ⇒ FAIL 
   status =  1 ⇒ GOOD 
 
The speed parameter is expressed in rpm. 
 
A read access to the ClkFreq Item returns an integer idicating the clock frequency as follows: 
 
 ClkFreq = -1 ⇒ FAIL 
 ClkFreq =  0 ⇒ 50 Hz 
 ClkFreq =  1 ⇒ 60 Hz 
 ClkFreq =  2 ⇒ 400 Hz 
 
A read access to the HVClkConf Item returns a string with the clock configuration like “clock:status”, where if: 
 
 Clock = 1 ⇒ MASTER 
 Clock = 0 ⇒ SLAVE 
 Status = -1 ⇒ FAIL 
 Status =  0 ⇒ NOT PRESENT 
 Status = +1 ⇒ GOOD 
 
see SYx527 User’s manual for further details. 
The IPaddress item allows to specify the system IP address (for example 192.9.200.48); 
 
The IPNetMsk  item allows to specify the system IP net mask (for example 255.255.255.0); 
 
The IPGw item allows to specify the system IP gateway (for example 0.0.0.0); 
 
The RS232Par item allows to configure the RS232 parameters (for example 115200:8:1:N:XON/XOFF); 
 
The CnetCrNum item allows to specify the CAENET crate number; see SYx527 User’s manual for further details. 
 
The SymbolicName Item allows to assign to the system a symbolic name. 
 
A read access to the Slots Item returns  the number of system’s slots.  
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A read access to the ConnStatus Item returns a string with the connection status of the system. If: 
 
 status = OK ⇒ CONNECTED 
   status = KO ⇒ DISCONNECTED 
 
A read access to the EventStatus Item returns a string with the connection type status of the system. If: 
 
 status = Enabled ⇒ CONNECTED with Event Mode ENABLED 
   status = Disabled ⇒ Event Mode NOT AVAILABLE 
 status = GlobalOPCDisable ⇒ Event Mode AVAILABLE BUT NOT ENABLED 
 
The OPCServerEventMode item allows to enable the Event Mode function (if supported) 
 TRUE ⇒ Event Mode function enabled (default) 
   FALSE ⇒ Event Mode function disabled 
When this item is set to False, the EventStatus Item reports GlobalOPCDisable 
 
The OPCServerVerifyTime item allows to set the Cached Values Timeout (i.e. a set value is considered good as long 
as the OPCServerVerifyTime)  
 2byte bit integer (unit = seconds); default value = 600s 
 
The OPCServerLiveInsertion item allows to enable the Live Insertion detection 
 TRUE ⇒ Live Insertion detected and automatic reboot  
   FALSE ⇒ Live Insertion ignored (default) 
 
The CPULoad item allows to monitor the load on the system CPU 
This item has the following format: value1:value5:value15 
Value1, value5 and value15 are the average CPU loads, calculated respectively over one, five and  fifteen minutes. 
 
The CmdQueueStatus item allows to monitor the number of commands in queue in the system; if CmdQueueStatus 
>0 then the System is performing commands on the boards, therefore monitor values may not be updated until all 
queued commands are executed. As soon as all commands are performed and CmdQueueStatus returns to 0, 
monitor values are updated to correct values. 
 
The MemoryStatus item allows to monitor the system memory usage 
This item has the following format: value0:value1:value2:value3  
Value0 is the total memory, value1 is the used memory, value2 is the free memory,  value3 is the buffers memory 

Table 4 – SY1527/ SY2527 System Items 

ItemID Data Type Access Rights  Description 
PowerSupplyName.Kill Boolean W Kill all channels 
PowerSupplyName.ClearAlarm Boolean W Clear alarm 
PowerSupplyName.EnMsg Boolean W To be implemented 
PowerSupplyName.DisMsg Boolean W To be implemented 
PowerSupplyName.Format Boolean W Execute Format command 
PowerSupplyName.RS232CmdOff Boolean W To be implemented 
PowerSupplyName.Sessions String R List Users connected to system 
PowerSupplyName.ModelName String R System name  
PowerSupplyName.SwRelease String R System firmware release 
PowerSupplyName.GenSignCfg 2-byte integer R/W GEN signal configuration 
PowerSupplyName.FrontPanIn 2-byte integer R System input status 
PowerSupplyName.FrontPanOut 2-byte integer R System output status 
PowerSupplyName.ResFlagCfg 2-byte integer R/W To be implemented 
PowerSupplyName.ResFlag 2-byte integer R To be implemented 
PowerSupplyName.HvPwSM String R Power supply modules status 
PowerSupplyName.FanStat String R Fan status 
PowerSupplyName.ClkFreq 2-byte integer R Clock frequency 
PowerSupplyName.HVClkConf String R Clock configuration 
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ItemID Data Type Access Rights  Description 
PowerSupplyName.IPAddr String R/W System IP address 
PowerSupplyName.IPNetMsk String R/W System IP net mask 
PowerSupplyName.IPGw String R/W System IP gateway 
PowerSupplyName.RS232Par String R/W RS232 parameters 
PowerSupplyName.CnetCrNum 2-byte integer R/W CAENET crate number 
PowerSupplyName.SymbolicName String R/W System symbolic name 
PowerSupplyName.Slots 2-byte integer R Slots number 
PowerSupplyName.ConnStatus String R connection status 
PowerSupplyName.EventStatus String R Event Status 
PowerSupplyName.OPCServerEventMode String R/W Event Mode status 
PowerSupplyName.OPCServerVerifyTime 2-byte integer R/W Verify Time value 
PowerSupplyName.OPCServerLiveInsertion String R/W Live Insertion status 
PowerSupplyName.CPULoad 2-byte integer R load on the system CPU 
PowerSupplyName.CmdQueueStatus 2-byte integer R number of commands in queue 
PowerSupplyName.MemoryStatus 2-byte integer R system memory usage 

SY1527 / SY2527 Board control 
This chapter describes the Items which are available for the control of a generic SY 1527 / SY 2527 system board  
(for example the Mod. A 1832N). The list of Items may differ for some custom boards (refer to the board’s manual 
for further details). 
 
A read access to the Model Item returns a string with the board model. 
 
A read access to the Description Item returns a string with the board synthetic description (for example “12 Ch Neg 
6 kV 1/0.2 mA”). 
A read access to the Fmw Release item returns a string with the board firmware release. 
 
A read access to the SerNum item returns the board serial number. 
 
A read access to the NrOfCh item returns the number of board’s channels. 
 
A read access to the BdStatus item returns the status of generic board's parameters, namely: 
 
bit 0: PowerFail; if 1, it indicates a failure in the channels local power supply 
bit 1: Firwmare Checksum Error; if 1, it indicates an error in the board firmware checksum 
bit 2: HVMax Calibration Error; if 1, it indicates that the board HVMax parameter (if present) is not calibrated 
bit 3: Temperature Calibration Error; if 1, it indicates that the board temperature sensor (if present) is not calibrated 
bit 4: Under Temperature; if 1, it indicates that the board temperature sensor (if present) signals a board 
temperature < 5 °C 
bit 5: Over Temperature; if 1, it indicates that the board temperature sensor (if present) signals a board 
temperature > 65 °C 
bits 6..31: Reserved for future use 
 
A read access to the HVMax item returns the voltage hardware limit set by trimmer on the board. 
 
A read access to the HVMax#EU item returns a string with the HVMax Engineering Units. 
 
A read access to the HVMax#HighEU item returns the highest possible HVMax value. 
 
A read access to the HVMax#LowEU item returns the lowest possible HVMax value. 
 
A read access to the Temp item returns the board’s temperature. 
 
A read access to the Temp#EU item returns a string with the Temp Engineering Units. 
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A read access to the Temp#HighEU item returns the highest possible Temp value. 
 
A read access to the Temp#LowEU item returns the lowest possible Temp value. 

Table 5 – SY1527/ SY2527 Board items 

ItemID Data Type Access Rights  Description 
PowerSupplyName.BoardXX.Model String R Board model 
PowerSupplyName.BoardXX.Description String R Board description 
PowerSupplyName.BoardXX.Fmw Release String R Board firmware release 
PowerSupplyName.BoardXX.SerNum 2-byte integer R Board serial number 
PowerSupplyName.BoardXX.NrOfCh 2-byte integer R Number of channels 
PowerSupplyName.BoardXX.BdStatus 2-byte integer R Board status 
PowerSupplyName.BoardXX.HVMax 4-byte real R Hardware voltage limit 
PowerSupplyName.BoardXX.HVMax#EU String R HVMax EU 
PowerSupplyName.BoardXX.HVMax#HighEU 8-byte real R HVMax upper limit 
PowerSupplyName.BoardXX.HVMax#LowEU 8-byte real R HVMax lower limit 
PowerSupplyName.BoardXX.Temp 4-byte real R Board temperature 
PowerSupplyName.BoardXX.Temp#EU String R Temperature EU 
PowerSupplyName.BoardXX.Temp#HighEU 8-byte real R Temp upper limit 
PowerSupplyName.BoardXX.Temp#LowEU 8-byte real R Temp lower limit 

SY1527 / SY2527 Channel control 
This chapter describes the items which are available for the control of a generic channel within the  
SY1527 / SY2527 system. The list of items may differ in case of channels belonging to custom boards (refer to the 
board’s manual for further details). 
 
The Name item allows to assign to the channel a symbolic name. 
 
The V0set item allows to set V0; 
 
A read access to the V0set#EU item returns a string with the V0set Engineering Units. 
 
A read access to the V0set#HighEU item returns the highest possible V0set value. 
 
A read access to the V0set#LowEU item returns the lowest possible V0set value. 

 
The I0set item allows to set I0; 
 
A read access to the I0set#EU item returns a string with the I0set Engineering Units. 
 
A read access to the I0set#HighEU item returns the highest possible I0set value. 
 
A read access to the I0set#LowEU item returns the lowest possible I0set value. 
 
The V1set item allows to set V1; 
 
A read access to the V1set#EU item returns a string with the V1set Engineering Units. 
 
A read access to the V1set#HighEU item returns the highest possible V1set value. 
 
A read access to the V1set#LowEU item returns the lowest possible V1set value. 
 
The I1set item allows to set I1; 
 
A read access to the I1set#EU item returns a string with the I1set Engineering Units. 
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A read access to the I1set#HighEU item returns the highest possible I1set value. 
 
A read access to the I1set#LowEU item returns the lowest possible I1set value. 

 
The RUp item allows to program the ramp-up rate; 
 
A read access to the RUp#EU item returns a string with the RUp Engineering Units. 
 
A read access to the RUp#HighEU item returns the highest possible RUp value. 
 
A read access to the RUp#LowEU item returns the lowest possible RUp value. 
 
The RDWn item allows to program the ramp-down rate; 
 
A read access to the RDWn#EU item returns a string with the RDWn Engineering Units. 
 
A read access to the RDWn#HighEU item returns the highest possible RDWn value. 
 
A read access to the RDWn#LowEU item returns the lowest possible RDWn value. 
 
The Trip item allows to program the trip time; 
 
A read access to the Trip#EU item returns a string with the Trip Engineering Units. 
 
A read access to the Trip#HighEU item returns the highest possible Trip value. 
 
A read access to the Trip#LowEU item returns the lowest possible Trip value. 
 
The SVMax item allows to set the software voltage limit; 
 
A read access to the SVMax#EU item returns a string with the SVMax Engineering Units. 
 
A read access to the SVMax#HighEU item returns the highest possible SVMax value. 
 
A read access to the SVMax#LowEU item returns the lowest possible SVMax value. 
 
The VMon item returns back the VMon value;. 
 
A read access to the VMon#EU item returns a string with the VMon Engineering Units. 
 
A read access to the VMon#HighEU item returns the highest possible VMon value. 
 
A read access to the VMon#LowEU item returns the lowest possible VMon value. 
 
The IMon item returns back the IMon value; 
 
A read access to the IMon#EU item returns a string with the IMon Engineering Units. 
 
A read access to the IMon#HighEU item returns the highest possible IMon value. 
 
A read access to the IMon#LowEU item returns the lowest possible IMon value. 
 
A read access to the Status item returns back a 16 bit pattern indicating channel status, as follows: 
  
 Bit 0: ON/OFF 
 Bit 1: Ramp Up 
 Bit 2: Ramp Down 
 Bit 3: OverCurrent 
 Bit 4: OverVoltage 
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 Bit 5: UnderVoltage 
 Bit 6: External Trip 
 Bit 7: Over HVmax 
 Bit 8: External Disable 
 Bit 9: Internal Trip 
 Bit 10: Calibration Error 

 Bit 11: Unplugged (“remote” boards only) 
 Bit12:  UnderCurrent 
 Bit13:  OverVoltage Protection 
 Bit14:  Power Fail 
 Bit15:  Temperature Error 

 
The Pw item allows to switch ON/OFF the channel. 
 
A read access to the Pw#CoOpen returns back the label “Off” associated to Pw=0. 
 
A read access to the Pw#CoClose item back the label “On” associated to Pw=1. 
 
The POn item allows to select the power ON option, as follows 
 
 POn=1 ⇒ Enabled 
 POn=0 ⇒  Disabled 
 
A read access to the POn#CoOpen returns back the label “Disabled” associated to POn=0. 
 
A read access to the POn#CoClose item returns back the label “Enabled” associated to POn=1. 
 
The PDwn item allows to select the power-down option, as follows 
 
 PDwn=1 ⇒ RAMP 
 PDwn=0 ⇒  KILL 
 
A read access to the PDwn#CoOpen item returns back the label “Kill” associated to PDwn=0. 
 
A read access to the PDwn#CoClose item returns back the “Ramp” associated to PDwn=1. 
 
The TripInt item allows to program the internal trip time. 
 
A read access to the TripInt#EU item returns a string with the TripInt Engineering Units. 
 
A read access to the TripInt#HighEU item returns the highest possible TripInt value. 
 
A read access to the TripInt#LowEU item returns the lowest possible TripInt value. 
 
The TripExt item allows to program the external trip time. 
 
A read access to the TripExt#EU item returns a string with the TripExt Engineering Units. 
 
A read access to the TripExt#HighEU item returns the highest possible TripExt value. 
 
A read access to the TripExt#LowEU item returns the lowest possible TripExt value. 

Table 6 – SY1527/ SY2527 Channel items 

ItemID Data Type Access Type  Description 
PowerSupplyName.BoardXX.ChanYYY.Name String R/W Channel name 
PowerSupplyName.BoardXX.ChanYYY.V0Set 4-byte real R/W Set V0 voltage limit 
PowerSupplyName.BoardXX.ChanYYY.V0Set#EU String R V0set  EU 
PowerSupplyName.BoardXX.ChanYYY.V0Set#HighEU 8-byte real R V0set upper limit 
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ItemID Data Type Access Type  Description 
PowerSupplyName.BoardXX.ChanYYY.V0Set#LowEU 8-byte real R V0set lower limit 
PowerSupplyName.BoardXX.ChanYYY.I0Set 4-byte real R/W Set I0 current limit 
PowerSupplyName.BoardXX.ChanYYY.I0Set#EU String R I0set  EU 
PowerSupplyName.BoardXX.ChanYYY.I0Set#HighEU 8-byte real R I0set upper limit 
PowerSupplyName.BoardXX.ChanYYY.I0Set#LowEU 8-byte real R I0set lower limit 
PowerSupplyName.BoardXX.ChanYYY.V1Set 4-byte real R/W Set V1 voltage limit 
PowerSupplyName.BoardXX.ChanYYY.V1Set#EU String R V1set  EU 
PowerSupplyName.BoardXX.ChanYYY.V1Set#HighEU 8-byte real R V1set upper limit 
PowerSupplyName.BoardXX.ChanYYY.V1Set#LowEU 8-byte real R V1set lower limit 
PowerSupplyName.BoardXX.ChanYYY.I1Set 4-byte real R/W Set I1 current limit 
PowerSupplyName.BoardXX.ChanYYY.I1Set#EU String R I1set  EU 
PowerSupplyName.BoardXX.ChanYYY.I1Set#HighEU 8-byte real R I1set upper limit 
PowerSupplyName.BoardXX.ChanYYY.I1Set#LowEU 8-byte real R I1set lower limit 
PowerSupplyName.BoardXX.ChanYYY.RUp 4-byte real R/W Set ramp-up rate 
PowerSupplyName.BoardXX.ChanYYY.RUp #EU String R Ramp up rate EU 
PowerSupplyName.BoardXX.ChanYYY.RUp #HighEU 8-byte real R Rup upper limit 
PowerSupplyName.BoardXX.ChanYYY.RUp #LowEU 8-byte real R RUp lower limit 
PowerSupplyName.BoardXX.ChanYYY.RDWn 4-byte real R/W Set ramp-down rate 
PowerSupplyName.BoardXX.ChanYYY.RDWn #EU String R Ramp down rate EU 
PowerSupplyName.BoardXX.ChanYYY.RDWn #HighEU 8-byte real R RDwn upper limit 
PowerSupplyName.BoardXX.ChanYYY.RDWn #LowEU 8-byte real R RDwn lower limit 
PowerSupplyName.BoardXX.ChanYYY.Trip 4-byte real R/W Set trip time 
PowerSupplyName.BoardXX.ChanYYY.Trip #EU String R Trip time EU 
PowerSupplyName.BoardXX.ChanYYY.Trip #HighEU 8-byte real R Trip time upper limit 
PowerSupplyName.BoardXX.ChanYYY.Trip #LowEU 8-byte real R Trip time lower limit 
PowerSupplyName.BoardXX.ChanYYY.SVMax 4-byte real R/W Set software voltage limit 
PowerSupplyName.BoardXX.ChanYYY.SVMax #EU String R SVMax EU 
PowerSupplyName.BoardXX.ChanYYY.SVMax#HighU 8-byte real R SVMax upper limit 
PowerSupplyName.BoardXX.ChanYYY.SVMax#LowEU 8-byte real R SVMax lower limit 
PowerSupplyName.BoardXX.ChanYYY.VMon 4-byte real R VMon 
PowerSupplyName.BoardXX.ChanYYY.VMon #EU string R VMon EU 
PowerSupplyName.BoardXX.ChanYYY.VMon#HighU 8-byte real R VMon upper limit 
PowerSupplyName.BoardXX.ChanYYY.VMon#LowEU 8-byte real R VMon lower limit 
PowerSupplyName.BoardXX.ChanYYY.IMon 4-byte real R IMon 
PowerSupplyName.BoardXX.ChanYYY.IMon #EU string R IMon EU 
PowerSupplyName.BoardXX.ChanYYY.IMon#HighU 8-byte real R IMon upper limit 
PowerSupplyName.BoardXX.ChanYYY.IMon#LowEU 8-byte real R IMon lower limit 
PowerSupplyName.BoardXX.ChanYYY.Status 2-byte integer R Channel status 
PowerSupplyName.BoardXX.ChanYYY.Pw boolean R/W Power ON/OFF 
PowerSupplyName.BoardXX.ChanYYY.Pw#CoClose string R Pw close label 
PowerSupplyName.BoardXX.ChanYYY.Pw#CoOpen string R Pw open label 
PowerSupplyName.BoardXX.ChanYYY.POn boolean R/W Power ON options 
PowerSupplyName.BoardXX.ChanYYY.POn#CoClose string R POn close label 
PowerSupplyName.BoardXX.ChanYYY.POn#CoOpen string R POn open label 
PowerSupplyName.BoardXX.ChanYYY.PDwn boolean R/W Power down options  
PowerSupplyName.BoardXX.ChanYYY.PDwn#CoClose string R PDwn close label 
PowerSupplyName.BoardXX.ChanYYY.PDwn#CoOpen string R PDwn open label 
PowerSupplyName.BoardXX.ChanYYY.TripInt 4-byte real R/W Set Internal trip time 
PowerSupplyName.BoardXX.ChanYYY.TripInt #EU string R Internal Trip time EU 
PowerSupplyName.BoardXX.ChanYYY.TripInt#HighU 8-byte real R Int. Trip time upper limit 
PowerSupplyName.BoardXX.ChanYYY.TripInt#LowEU 8-byte real R Int. Trip time lower limit 
PowerSupplyName.BoardXX.ChanYYY.TripExt 4-byte real R/W Set external trip time 
PowerSupplyName.BoardXX.ChanYYY.TripExt #EU string R External Trip time EU 
PowerSupplyName.BoardXX.ChanYYY.TripExt#HighU 8-byte real R Ext. Trip time upper limit 
PowerSupplyName.BoardXX.ChanYYY.TripExt#LowEU 8-byte real R Ext. Trip time lower limit 
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6. VME8x00 Crates 

VME8x00 control 
CAEN HV OPC Server release 5.X supports the CAEN VME8x00 VME Powered Crates. Connect the VME8x00 to the 
Host PC via Ethernet, then  launch the OPC Server configurator (see § 2): 
Select “add entry”, then type name of the Crate, IP address, user name and password.  

Select OK, at this point the configurator will return the connection status; for example 

P.S. Name Sys type Conn. Type Address Status 

VME Crate V8100 TCP/IP 10.07.27 Ok 

Now the board is ready to be accessed via OPC server; launch the OPC Client (for example the Matrikon OPC 
Explorer, which is available as freeware): 

 
Fig. 5: Matrikon OPC Explorer start up 

Select CAEN HV OPC Server in the Host menu, then click on “Connect” 

Click on “Tag” Icon in the upper tool bar: 

 
Fig. 6: Matrikon OPC Explorer tool bar 

Select “Add Tags”, the following window will open: 
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Fig. 7: Matrikon OPC Explorer; VME8100 item list 

The VME8100 is detected and the following subfolders are available: VME, BoardXX, ChanXXX; each subfolder 
contains the relevant OPC items. 

In order to edit an Item, double click on it and it will be added to the list on the rightmost tab: 

 
Fig. 8: Matrikon OPC Explorer; VME8100 item selection 

Click OK, then the Items will be ready to be monitored and/or edited; in order to do this, right click on the Item 
name and select “Write values”: 
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Fig. 9: Matrikon OPC Explorer; VME8x100item content 

The following pop up window will allow to edit the Item value: 

 
Fig. 10: Matrikon OPC Explorer; VME8x100 item update 

Then it is possible to save the session onto file, by selecting: 
File > save session 
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For the VME8x00 Crates the available OPC items are the following: 

System items Board items Channel items 

 

 

 

Fig. 11: VME8x100 items 



CAEN  Electronic Instrumentation 
 

CAEN OPC Server 5.x 31 

7. V65XX VME HV Power Supplies 

V65XX control 
CAEN HV OPC Server release 5.X supports the CAEN V65XX VME Programmable HV Power Supplies. The support is 
available when the V65XX are managed through the CAEN VME Controllers; if a third part controller/bridge is used 
(for example VME SBC), it is necessary to provide a “CAENComm equivalent” library by exporting the functions used 
by the software (see www.caen.it website for all details about VME Controllers and Libraries).  

Install the V65XX board properly into the VME Crate, then launch the OPC Server configurator (see § 2): 

Select “add entry”, then type name of the power supply (for example V6534N), link type ( “optical link”, if using a 
V2718 VME bridge or USB if a V1718 is used instead) and VME base address of the board (for example 0x3210):  

Select OK, at this point the configurator will return the connection status; for example 

P.S. Name Conn. Type Address Status 

V6534N OPTLINK 0_0_32100000 Ok 

Now the board is ready to be accessed via OPC server; launch the OPC Client (for example the Matrikon OPC 
Explorer, which is available as freeware): 

 
Fig. 12: Matrikon OPC Explorer start up 

Select CAEN HV OPC Server in the Host menu, then click on “Connect” 

Click on “Tag” Icon in the upper tool bar: 

 
Fig. 13: Matrikon OPC Explorer tool bar 

Select “Add Tags”, the following window will open: 

http://www.caen.it/
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Fig. 14: Matrikon OPC Explorer; V6534N item list 

The V6534N is detected and the following subfolders are available: V6534N, BoardXX, ChanXXX; each subfolder 
contains the relevant OPC items. 

In order to edit an Item, double click on it and it will be added to the list on the rightmost tab: 
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Fig. 15: Matrikon OPC Explorer; V6534N item selection 

Click OK, then the Items will be ready to be monitored and/or edited; in order to do this, right click on the Item 
name and select “Write values”: 

 
Fig. 16: Matrikon OPC Explorer; V6534N item content 

The following pop up window will allow to edit the Item value: 

 
Fig. 17: Matrikon OPC Explorer; V6534N item update 

Then it is possible to save the session onto file, by selecting: 
File > save session 
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For the V65XX VME Programmable HV Power Supply boards the available OPC items are the following: 

System items Board items Channel items 

 

 

 

Fig. 18: V6534N items  
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8. OPC clients connection 
The CAEN HV OPC Server has been successfully tested with Northern Dynamic OPC Browser ver. 1.0 and the 
following OPC clients: 

 
• National Instruments Server Explorer ver. 1.1 
• Softing OPC Client ver. 2.0 
• National Instruments LabView 5.x and later 
 
 This chapter is mainly to help the User to familiarise with OPC clients operation. 

Browsing the server address space 
This section illustrates a typical OPC browse session. Start, for example, the ND OPC Browser, go to File →Browse 
OPC Server…, select CAEN.HVOPCServer from the list in the dialog window and then click “OK”. 
 
 

 
Fig. 19: Selecting the OPC server 

In the Browser window is graphically depicted the server address space (see Fig. 3.1). By right clicking on the item 
tag, it is possible to access the item’s Specific properties, like shown in the figure below. 
 

 
Fig. 20: The item’s Specific properties 
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National Instruments LabView 5.x and later releases 
National Instruments LabView 5.x and later releases include a native OPC Client embedded into its set of VIs based 
on Datasocket technology. You can develop your own LabView application basing it on Datasocket, or you can use 
some examples provided by National. In this section we will see how to read the temperature of the A1832 board. 
In the main dialog of LabView press the "Search examples" button. In the Search Examples Help follow the "OPC" 
link. Choice the "Browse to OPC Item" example and run it. In the "Select URL path" window select 
CAEN.HVOPCserver  on the machine where it has been registered. 

 
Fig. 21: Selecting URL path to server 

This operation causes the automatic start-up of the OPC server; you can browse the server address space and select 
an ItemID (in our case we will choice the temperature of the board in slot 04: system0.Board04.Temp). 
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Fig. 22: Selecting an item 

The fully qualified ItemID is then showed in the "URL" window of the VI's front panel. 
 

 
Fig. 23: "URL" window of the VI's front panel 

If you want to monitor the current values of the temperature, you can use the "Demo OPC CLient" example: simply 
set the Hostname (leaving it blank if the OPC server is on the same PC as LabView), the Server Name 
(CAEN.HVOPCserver) and the Item name (system0.Board04.temp) and  then launch the VI. 
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Fig. 24: Temperature plot 

National Instruments Server Explorer 
This section illustrates how to access data items by the help of NI Server Explorer. In the Server Explorer window 
select CAEN.HVOPCServer, in the menu bar go to Servers→Connect to Server and choose “Connect”. To create a 
group, go in the menu bar to Edit→Add, specify the group name in the dialog box (for example “group0”) and then 
click on the Add button. 
 

 
Fig. 25: Creating a group 

To add items, select a group in the main window (for example “group0”), go in the menu bar to Edit→Add, select 
the desired items into the Item definition window and then click on the Add button. 
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Fig. 26: Adding items to a group 

 
Fig. 27: Active items list 

The list of active items appears in the Server explorer main window. To read/write data items or check items’ 
properties, simply double click on the item tag in the main window and select the Read&Write option (see the 
figure below). 
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 Fig. 28: Read/write data  

Softing OPC Client 
This section illustrates how to access data items by the help of the Softing OPC Client. In the main menu go to 
Server→Add, in the Browse window double click on “CAEN OPC Server for Power Supplies” then push the OK 
button; to start the server go to Server→Start→Deep. 
 

 
Fig. 29: Connect to OPC server 

To add a group, go in the main menu to Group→Add, specify the group name in the dialog box and then go to 
Group→Start →Deep. To add items, select a group, go to Items→Add, specify the ItemID in the dialog box and click 
OK, then go to Item→Start →Deep. Item properties are indicated in the Properties window. 
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Fig. 30: The VMon item 

 
Fig. 31: The VMon item properties 
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